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Abstract: The main aim of this study is to examine the measurement invariance of 

the structural equating model constructed on the Awareness and Exposure 

subscales of Nanoscience and Nanotechnology Awareness Scale (NSTAS) test for 

three teacher branches, three school types, and two genders by using the covariance 

structural analysis to test configural and metric invariances. The other aim of this 

study is showing how to use the IBM AMOS-24 software package with examples 

to address the issue of measurement invariance using the covariance structural 

analysis approach. Study sample was 1039 complete records gathered from science 

teachers with convenience sampling. Research data were collected in two stages. 

In the first stage, data were obtained from 624 teachers who participated to the 

study in the 2015-16 academic year. In the second stage, data were obtained in 

2019 from 415 teachers via a link to access to the scale and all the instructions for 

the NSTAS in 2019. The covariance structures analysis was used to examine the 

measurement invariance of the scale. The comparative fit index was used to 

compare the measurement invariance in the measurement model. The study 

revealed that configural, measurement weight and structural covariance 

invariances were ensured for branches, school types and genders. Residual 

invariance was ensured only for gender. As a result, it was concluded that the 

NSTAS scale was not biased for teacher branches, school types or gender. NSTAS 

scale is recommended for the purposes of comparing branch, school type and 

gender groups. 

1. INTRODUCTION 

Nanoscience and nanotechnology (NSNT) are an abstract and complex topic with various 

applications resulting from the manipulation of atoms and molecules. Nanotechnology, one of 

the most promising technologies of the 21st century, utilizes devices, structures, and molecules 

on the scales of nanometers ranging between 1 and 100 nm (Bayda et al., 2020). The responsible 

development of nanotechnology that addresses the ethical, legal, and societal issues together 

with research, commercialization, worker education, and public engagement is assumed to 
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determine public trust and the future of innovation driven by NSNT. However, describing a 

world people cannot see and physically interact needs enhancement of understanding these 

emerging technologies using science communication/citizen-science to reach its full 

revolutionary potential. Public attitudes, and reflexive governance are essential to public 

acceptance of NSNT innovation (Boholm & Larsson, 2019). 

It is one of the most rapidly growing/broad multidisciplinary fields in science, technology, life 

sciences and engineering research/innovation and is founded on the convergence of traditional 

disciplines to create, study, and apply materials at the nanoscale (Holland et al., 2018). 

Nanotechnology generates great opportunities for cutting-edge research in science and for 

innovation in industrial production and affects the everyday lives. Presently science teachers 

typically have insignificant exposure to NSNT, and few opportunities to understand the basic 

concepts. Developing countries must take their positions in the world nanotechnology market 

and industry, so planning for good NSNT training is especially important for developing 

countries. Depending on new information and how it is presented public attitudes toward NSNT 

may become unstable at times, show rapid change potential since attitudes depend on values, 

beliefs, and worldviews rather than on facts (Boholm & Larsson, 2019). 

Developments and economic impact on commerce and society have brought nanotechnology 

education to the forefront. Along this line, developed countries have made NSNT education a 

priority, with intensive education planning and research at primary level being launched. The 

significance of awareness should be emphasized as an initial step in all nano education 

processes. The rapid development and impact of NSNT on economy has led policy makers and 

educators to focus on nanotechnology education (Laherto, 2010). Integrating a new 

multidisciplinary science at the interface of different scientific and engineering disciplines into 

the secondary school is a significant endeavor; however, it can be spread throughout a well-

designed secondary science education curriculum. Furthermore, factors affecting awareness 

and knowledge level of teachers/teacher trainees in NSNT should be determined and analyzed 

before implementing education programs (Hingant & Albe, 2010; Jones et al., 2013). 

Communicating NSNT to different levels of students places the teacher at the center of learning 

and teaching activities for NSNT; a significant responsibility (Hingant & Able, 2010). If 

teachers are not familiar with NSNT, teaching these topics will be a major challenge for them 

(Greenberg, 2009). Therefore, teachers need to develop their own knowledge and awareness of 

NSNT to understand and be able to communicate these issues to their students (Blonder et al., 

2014). The responsible development of NSNT to safeguard the environment, human health, and 

safety, and to ensure that the new technology benefits society, requires citizen involvement, 

dialog, and participation. These cannot be achieved without teacher education and training in 

NSNT.  

It is provided in AERA, APA, and NCME (2014) as standards for evidence regarding internal 

structure, “if the rationale for a test score interpretation for a given use depends on premises 

about the relationship among test items or among parts of the test, evidence concerning the 

internal structure of the test should be provided.” Theoretical structure of a measuring tool 

raises the concern whether it works the same in different groups, when the differences between 

the groups are tested. Ensuring the measurement invariance of measuring tools is neglected in 

almost all research. As Millsap and Yun-Tein (2004) pointed out, the extension of the analysis 

to the multiple-population case is less well-known, especially for ordered-categorical data in 

the literature on factor analysis. As Camilli (2006) pointed out that measurement invariance 

contributes to validity evidence in that scores from a tool are subject to issues of bias and lack 

of fairness if invariance does not hold. 

Whether the Nanoscience and Nanotechnology Awareness Scale (NSTAS), (İpek et al., 2020) 

measures the same characteristics for three different teacher branches, three school types, and 
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two genders are determined as sub-groups to test the measurement invariances. When different 

groups are to be compared, the obtained scores from the scale should not be biased (Tan & 

Pektaş, 2020). Further investigations are necessary to explain/justify the question of whether 

the scale items perform similarly across subgroups, and one way to examine this question is 

through assessing the measurement invariance of a scale (Chung et al., 2016). There are several 

studies in the literature on measurement invariance for test scores (Arana et al., 2018; Camerota 

et al., 2018). For a measurement model to have the same structure across different groups, the 

factor loadings of the items in a scale, and the correlations and variances among the identified 

factors, should be the same (Tan & Pektaş, 2020). While examining the measurement invariance 

of a measurement model between groups, the model created at each stage is built on the model 

created in the previous stage, i.e., the models are nested. 

As stated by Byrne (2016, pp. 227-228), “In seeking evidence of multigroup equivalence, 

researchers are typically interested in finding the answer to one of five questions. First, do the 

items comprising a particular measuring instrument operate equivalently across different 

populations? In other words, is the measurement model group-invariant? Second is the factorial 

structure of a single instrument or of a theoretical construct equivalent across populations? 

Third, are certain paths in a specified causal structure equivalent across populations? Fourth are 

the latent means of constructs in a model different across populations? Finally, does the factorial 

structure of a measuring instrument replicate across independent samples drawn from the same 

population? This latter question addresses the issue of cross-validation.”  

As Chung et al. (2016) stated, configural invariance is the fact that factor structures between 

groups are equivalent. In other words, configural invariance tests that the same pattern of item-

factor loadings exists across groups compared, which requires that the same items have nonzero 

loadings on the same factors. To observe whether the other steps of invariance are ensured, 

comparisons are made based on the configural invariance values (Cheung & Rensvold, 2002; 

Vandenberg & Lance, 2000). On the other hand, metric invariance refers to equivalence among 

factor loadings. Chung et al. (2016) emphasized metric invariance, in addition to configural 

invariance, requires that unstandardized factor loadings be the same across groups. The scalar 

invariance is based on the equivalence of factor covariances across groups. Therefore, scalar 

invariance, addition to configural and metric invariance, factor variances and factor covariances 

are the same across groups. It is a kind of invariance where factor covariances are equalized 

across the groups after configural and metric invariances are ensured (Cheung & Rensvold, 

2002; Meredith, 1993). Strict invariance requires proof that errors do not vary by group. Strict 

invariance, addition to configural, metric and scalar invariance, the error variances are the same 

across groups. It is a type of invariance where all factor loadings, factor variances, factor 

covariances and error variances are constrained (Cheung & Rensvold, 2002).  

In the present study, the stages of identifying configural and metric measurement invariances 

of NSTAS were realized by using the covariance structural analysis (COVS) approach. In 

COVS approach of testing measurement invariances, only the variances and the covariances 

between paired observed variables are used as observed variables. 

1.1. Aim of the Study 

The very first step in nano education at any level is ensuring the awareness of the teachers 

(Bryan et al., 2012; Enil & Köseoğlu, 2016). The present study aimed to examine the 

measurement invariance of the structural equating model constructed on the Awareness and 

Exposure subscales of NSTAS test for three science teacher branches, three school types, and 

two genders by using the covariance structural analysis (COVS). In this study we also use the 

IBM AMOS-24 software package as illustrated with examples to address measurement 

invariances using the covariance structural analysis approach. This is a significant contribution 
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to the field of science education measurement and assessing since most of the measurement 

invariance studies are confined purely to the measurement field. 

2. METHOD 

2.1. The Research Model 

This study is a descriptive study, as it is intended to present the present situation in terms of 

measurement invariance of NSTAS structural model and no variable is manipulated. Details of 

the scale have been published elsewhere (İpek et al., 2020). 

2.2. The Study Group 

The sample of the study consists of 1039 complete records (without any missing records) 

gathered from science teachers. Research data were collected in two stages. The data in the first 

stage were obtained from 624 teachers in the 2015-16 academic year, used in İpek's (2017) 

doctoral thesis.  

Data in the second stage were obtained during 2019 by using a link to access the NSTAS scale 

and all instructions. In rare cases the scale was administered face-to-face to the respondents. 

Convenience sampling approach was used to form the study group. The distribution of the 1039 

science teachers to the branches, school types and gender were as follows: Biology 38.5%; 

physics 31.5%, and chemistry 30.0%; science high school 16.3%, Anatolian high school 56.4% 

and vocational high school 27.3%; and male 45.4% and female 54.6%. 

2.3. Data Collection Instruments 

The Nanotechnology Awareness Instrument (NAI, Dyehouse et al., 2008, refer to Appendix for 

the instrument) was adapted into a Turkish version and named Nanoscience and 

Nanotechnology Awareness Scale (NSTAS, refer to Appendix for the scale); validity and 

reliability of the Turkish version were tested by the authors. The original scale (NAI) assessed 

changes in higher education student awareness, exposure, and motivation for nanotechnology, 

as well as factual knowledge about nanotechnology. The nanotechnology awareness subscale 

measures whether respondents “know something about nanotechnology” and whether they 

“have heard about nanotechnology and its applications”. Awareness is supported by exposure, 

where respondents’ previous exposure to nanotechnology may enhance their awareness and 

knowledge. NAI consisted of two parts: Items in Part A regarding awareness, exposure, and 

motivation subscales, and Part B regarding factual knowledge about nanotechnology 

(Dyehouse et al., 2008). Our version, the NSTAS, has three subscales, the Awareness (8 items) 

and Exposure (6 items) subscales adopted from NAI (total of 14 items), and the subscale 

Knowledge developed by the authors. The Awareness (8 items) and Exposure (6 items) 

subscales were used to perform measurement invariance analysis. The Cronbach alpha internal 

consistency coefficient of the Awareness (8 items) subscale was found to be .934 and Exposure 

subscale .845. Stratified alpha reliability coefficient for whole scale (with Awareness and 

Exposure, 14 items) was found to be .945. 

2.4. Data Analysis 

The covariance structural analysis approach was utilized to examine the measurement model 

invariances by sub-groups, explained above. The multivariate normal distribution assumption 

was tested for each subgroup. The multivariate normal distribution assumption was not met for 

any subgroup. Therefore, bootstrap estimation with 500 bootstrap samples was used to estimate 

the model parameters. In testing measurement invariances between the .01 reduction criterion 

the CFI value (ΔCFI) was used. Based on the conditions for ensuring measurement invariance, 

this has been accepted as proof for the presence of measurement invariance (Cheung & 
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Rensvold, 2002). Also, a difference of less than .01 in the ΔCFI index supports the less 

parameterized model (Chung et al., 2016). 

During the analyses, the operations were done via the IBM AMOS-24 package program and 

explained as follows (Byrne, 2016): 

IBM AMOS-24 operations for configural invariance.  

1. The groups are defined by selecting the Manage Groups function from the Analyze menu 

in the AMOS program.  

2. Subsequently, the data files are assigned to the defined groups by selecting the Data Files 

function from the File menu.  

3. The Emulisrel6 box is ticked by selecting Estimation from Analysis Properties in the View 

menu.  

4. Finally, the analysis is run by selecting Calculate Estimates from the Analyze menu. 

IBM AMOS-24 operations for configural, factor loading, structural variances and 

measurement residual invariances.  

Until the stage of making the predictions, as an addition to the operations mentioned above, the 

parameters to be predicted in the model are labelled manually or automatically. For automatic 

labelling,   

1. Multiple Group Analysis function is selected from the Analyze menu.  

2. The parameters to be constrained are selected in the Multiple-Group Analysis dialog box. 

3. The analysis is run by selecting Calculate Estimates from the Analyze menu. 

3. RESULT / FINDINGS 

3.1. Measurement Model 

The baseline measurement model, which is used for eight subgroups, is presented in Figure 1, 

below. 

Figure 1. The baseline measurement model for the multiple-group invariance of the NSTAS. 
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As it seen in Figure 1, Awareness latent variable is measured with 8 items (A1 to A8) and 

Exposure latent variable is measured with 6 items (B1 to B6). There are covariance connections 

between the Awareness and Exposure latent variable and 11 covariance connections between 

some measurement residual variables in the baseline model. Item A5 was taken as reference for 

the scale of Awareness latent variable and item B3 for the scale of Exposure latent variable. 

3.2. Measurement Invariance by Branch 

The goodness of fit indices of the baseline measurement model used for all subgroups created 

within the scope of the study are presented below. Having good model fit indexes in all 

subgroups for the baseline measurement model is a prerequisite for invariance analysis.  

Step 1: Goodness of Fit Indexes of the Baseline Measurement Model for Branch  

The baseline model is presented in Figure 1. In the baseline measurement model based on the 

branches of teachers, the goodness of fit indexes (Schermelleh-Engel et al., 2003) were found 

as follows:  

✓ for Physics teachers 𝑋65
2 =215.097; 𝑋2/sd=3.309; GFI=0.916; CFI=0.959 and 

RMSEA=.084;  

✓ for Chemistry teachers 𝑋65
2 =175.102; 𝑋2/sd=2.694; GFI=0.927; CFI=0.964 and 

RMSEA=.074; and  

✓ for Biology teachers 𝑋65
2 =216.704; 𝑋2/sd=3.334; GFI=0.931; CFI=0.961 and 

RMSEA=.076.  

In conclusion, the baseline measurement model in Figure 1 displayed a high level of model fit 

for Physics, Chemistry, and Biology teachers.  

Step 2: Configural invariance of the Measurement Model for Branch   

As stated by Byrne (2016), to ensure configural invariance, factor loading patterns and the 

number of factors should be similar for each group. The measurement model based on teachers’ 

branch has provided configural invariance with 𝑋195
2 =606.903; 𝑋2/df=3.112; GFI=.925; 

CFI=.961 and RMSEA=.045. That is, in this unconstrained measurement model, the factor 

structure for Physics, Chemistry, and Biology Teacher groups was found to be similar. These 

results show that the model in Figure 1 is a valid measurement model for all subgroups. The 

unstandardized estimated parameters (regression weights, covariances, and variances) of three 

branches for configural invariance are given for each group in Tables 1a, 1b and 1c, below. 

Table 1a. Regression weight estimates for configural model. 

 Estimates 

Regression Weights Physics Chemistry Biology 

A7 <--- Awareness .812** .624** 1.009** 

A6 <--- Awareness .857** .710** .924** 

A5 <--- Awareness 1.000 1.000 1.000 

A4 <--- Awareness .984** 1.000** 1.033** 

A3 <--- Awareness .936** .868** 1.068** 

A2 <--- Awareness .888** .877** .941** 

A1 <--- Awareness .959** .973** 1.101** 

B6 <--- Exposure .402** .385** .221** 

B5 <--- Exposure .455** .473** .313** 

B4 <--- Exposure .620** .619** .450** 

B3 <--- Exposure 1.000 1.000 1.000 

B2 <--- Exposure .830** .820** .875** 

B1 <--- Exposure .430** .481** .437** 

A8 <--- Awareness .921** .911** 1.093** 

*: p<.05;  **: p<.01 
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Table 1b. Covariance estimates for configural model. 

 Estimates 

Covariance Physics Chemistry Biology 

Awareness <--> Exposure .897** .650** .670** 

ea7 <--> ea6 .412** .438** .310** 

ee6 <--> ee4 .564** .565** .608** 

ea5 <--> ea3 .039 .058 .203** 

ee5 <--> ee3 .093** -.037 .003 

ea4 <--> ea2 .033 .096** .113** 

ea2 <--> ea1 .073* .080** .114** 

ea7 <--> ea8 .004 .040 .040 

ee6 <--> ee5 .806** .506** .611** 

ee5 <--> ee4 .706** .608** .725** 

ee2 <--> ee1 .139** .201** .050 

ea5 <--> ea2 .046 .036 .030 

*: p<.05;  **: p<.01 

Table 1c. Variance estimates for configural model. 

 Estimates 

Variances Physics Chemistry Biology 

Awareness 1.172** 1.021** .749** 

Exposure 1.497** 1.570** 1.617** 

ea7 .730** .805** .696** 

ea6 .560** .636** .551** 

ea5 .422** .393** .575** 

ea4 .339** .321** .383** 

ea3 .550** .527** .494** 

ea2 .372** .386** .430** 

ea1 .554** .449** .534** 

ee6 1.056** 1.001** .825** 

ee5 1.070** 1.084** .911** 

ee4 1.193** 1.093** 1.142** 

ee3 .477** .450** .469** 

ee2 .336** .415** .254** 

ee1 .530** .442** .426** 

ea8 .522** .432** .514** 

*: p<.05;  **: p<.01 

Step 3: Configural and Measurement Weights Invariance of the Measurement Model for 

Branch  

As Byrne (2016) notes, in testing the measurement, structural and measurement error 

invariance, the focus is on the parameters, related to the measurement model, structural 

components and measurement errors, being equal in all groups. The measurement model based 

on teachers’ branch has provided configural and measurement weights invariance with 

𝑋219
2 =654.437; 𝑋2/df=2.988; GFI=.919; CFI=.959 and RMSEA=.044. For testing the 

significant model differences, the CFI change value that we take the criteria was found to be 

less than .01 (ΔCFI= .002). So, difference between configural invariance model and configural 

and measurement weights invariance model is not significant. In other words, the measurement 

model with restricted regression weights for Physics, Chemistry and Biology Teacher groups 

have been found to have good fit indexes with no significant CFI changes. So, measurement 

weights are equal for Physics, Chemistry, and Biology Teacher groups in the population. 

The unstandardized estimated parameters (constrained regression weights, covariances, and 

variances) of three branches for configural and measurement weights invariance are given for 

each group in Tables 2a, 2b, and 2c below. 
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Table 2a. Regression weight estimates for configural and constrained measurement weights model. 

 Estimates 

Constrained Regression Weights 

Physics  

Chemistry  

Biology 

A7 <--- Awareness .815** 

A6 <--- Awareness .839** 

A5 <--- Awareness 1.000 

A4 <--- Awareness 1.004** 

A3 <--- Awareness .967** 

A2 <--- Awareness .900** 

A1 <--- Awareness 1.010** 

B6 <--- Exposure .318** 

B5 <--- Exposure .397** 

B4 <--- Exposure .549** 

B3 <--- Exposure 1.000   

B2 <--- Exposure .845** 

B1 <--- Exposure .454** 

A8 <--- Awareness .968** 

*: p<.05;  **: p<.01 

Table 2b. Covariance estimates for configural and constrained measurement weights model. 

 Estimates 

Covariance   Physics Chemistry Biology 

Awareness <--> Exposure .873** .622** .726** 

ea7 <--> ea6 .417** .431** .328** 

ee6 <--> ee4 .590** .588** .607** 

ea5 <--> ea3 .040 .053 .197** 

ee5 <--> ee3 .089** -.025 .000 

ea4 <--> ea2 .034 .106** .106** 

ea2 <--> ea1 .070* .082** .110** 

ea7 <--> ea8 .002 .031 .059* 

ee6 <--> ee5 .821** .529** .612** 

ee5 <--> ee4 .724** .639** .721** 

ee2 <--> ee1 .126** .194** .056 

ea5 <--> ea2 .050 .040 .026 

*: p<.05;  **: p<.01 
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Table 2c. Variance estimates for configural and constrained measurement weights model.   

 Estimates 

Variances Physics Chemistry Biology 

Awareness 1.121** .925** .869** 

Exposure 1.502** 1.563** 1.623** 

ea7 .732** .804** .734** 

ea6 .567** .627** .559** 

ea5 .429** .407** .567** 

ea4 .340** .339** .374** 

ea3 .547** .514** .497** 

ea2 .373** .393** .422** 

ea1 .548** .454** .530** 

ee6 1.080** 1.019** .829** 

ee5 1.079** 1.113** .907** 

ee4 1.221** 1.123** 1.137** 

ee3 .481** .470** .454** 

ee2 .318** .387** .285** 

ee1 .521** .445** .425** 

ea8 .520** .428** .528** 

*: p<.05;  **: p<.01 

Step 4: Configural, Measurement Weight and Structural Covariance Invariance of the 

Measurement Model for Branch  

The measurement model based on teachers’ branch has provided configural, measurement 

weight, and structural covariance invariance with 𝑋225
2 =667.589; 𝑋2/df=2.967; GFI=.918; 

CFI=.958 and RMSEA=.044. For testing the significant model differences, the CFI change 

value that we take the criteria was found to be less than .01 (ΔCFI=.003). So, difference 

between configural invariance model and configural, measurement weight and structural 

covariance invariance model is not significant. In other words, the measurement model with 

constrained regression weights and structural covariances for Physics, Chemistry and Biology 

Teacher groups have good fit indexes with no significant CFI changes. So, measurement 

weights and structural covariances are equal for Physics, Chemistry, and Biology Teacher 

groups in the population. 

The unstandardized estimated parameters (constrained regression weights, constrained 

structural covariances, other covariances and variances) of three branches for Configural, 

Measurement Weights, and Structural Covariance Invariance model are given for each group 

in Tables 3a, 3b, and 3c below.  

In this model, since we have two structural variables (Awareness and Exposure), there is one 

structural covariance and two structural variances to be constrained additionally. 
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Table 3a. Regression weight estimates for configural, constrained measurement weights, and 

constrained structural covariances model.   

 Estimates 

Constrained Regression Weights 

Physics  

Chemistry  

Biology 

A7 <--- Awareness .815** 

A6 <--- Awareness .838** 

A5 <--- Awareness 1.000 

A4 <--- Awareness 1.004** 

A3 <--- Awareness .967** 

A2 <--- Awareness .901** 

A1 <--- Awareness 1.009** 

B6 <--- Exposure .318** 

B5 <--- Exposure .399** 

B4 <--- Exposure .550** 

B3 <--- Exposure 1.000 

B2 <--- Exposure .846** 

B1 <--- Exposure .454** 

A8 <--- Awareness .968** 
*: p<.05;  **: p<.01 

Table 3b. Covariance estimates for configural, constrained measurement weights, and constrained 

structural covariances model.   

 Estimates 

Covariance   Physics Chemistry Biology 

Awareness <--> Exposure .742** .742** .742** 

ea7 <--> ea6 .420** .429** .326** 

ee6 <--> ee4 .594** .585** .607** 

ea5 <--> ea3 .041 .056 .195** 

ee5 <--> ee3 .089** -.025 .001 

ea4 <--> ea2 .033 .105** .105** 

ea2 <--> ea1 .069* .082** .109** 

ea7 <--> ea8 .003 .030 .058 

ee6 <--> ee5 .824** .526** .612** 

ee5 <--> ee4 .728** .635** .721** 

ee2 <--> ee1 .123** .195** .057 

ea5 <--> ea2 .049 .041 .026 
*: p<.05;  **: p<.01 
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Table 3c. Variance estimates for configural, constrained measurement weights, and constrained 

structural covariances model.   

 Estimates 

Variances Physics Chemistry Biology 

Awareness .967** .967** .967** 

Exposure 1.562** 1.562** 1.562** 

ea7 .735** .802** .731** 

ea6 .570** .624** .558** 

ea5 .429** .412** .565** 

ea4 .339** .339** .374** 

ea3 .548** .515** .494** 

ea2 .371** .392** .421** 

ea1 .546** .457** .528** 

ee6 1.082** 1.016** .829** 

ee5 1.082** 1.110** .908** 

ee4 1.226** 1.119** 1.137** 

ee3 .465** .500** .456** 

ee2 .313** .384** .287** 

ee1 .520** .448** .425** 

ea8 .522** .427** .527** 

*: p<.05;  **: p<.01 

Step 5: Configural, Measurement Weight, Structural Covariance, and Measurement 

Residual Invariance of the Measurement Model for Branch  

The goodness of fit indexes for this model were found to be good with 𝑋275
2 =846.863; 

𝑋2/df=3.080; GFI=.895; CFI=.946 and RMSEA=.045. However, for testing the significant 

model differences, the CFI change value was higher than .01 (ΔCFI=.015). It is clear that, 

difference between configural invariance model and configural, measurement weight, structural 

covariance, and measurement residual invariance model is significant. Therefore, measurement 

residual estimates are not identical for Physics, Chemistry, and Biology Teacher groups in the 

population. 

Because all the model parameters are constrained equal, the unstandardized estimated 

parameters of the model are given in the path diagram, Figure 2, below.   

The main findings regarding the measurement invariance according to the branches are 

presented in Table 4 below. As can be observed in Table 4, according to the unconstrained 

(configural) model, the changes in CFI in the models obtained by constraining, in sequence, 

measurement weights, and structural covariances were less than .01. However, when error 

residuals constrained the changes, CFI was found to be more than .01. Hence, it was concluded 

that the measurement model has provided configural, measurement weight, and structural 

covariance invariance; but did not provide measurement residual invariance across three 

branches. 
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Figure 2. Path diagram for configural, measurement weight, structural covariance, and measurement 

residual invariance of the measurement model for branch.  

 
Note: Only 3 covariance estimates (ee5 < -- > ee3=.017 with p=.389; ea7 < -- > ea8=.032 with p=.062; and ea5 < 

-- > ea2=.037 with p=.013) were not significant, all the other parameters were significant. 

 

Table 4. Configural, measurement weight, structural covariance, and measurement residual invariance 

results by branch. 

Model 
Number of 

parameters 
𝑋2 df 𝑋2/𝑑𝑓 CFI ΔCFI RMSEA 

1. Unconstrained (Configural) 120 606.903 195 3.112 .961  .045 

2. Measurement Weights  96 654.437 219 2.988 .959 .002 .044 

3. Structural Covariances  90 667.589 225 2.967 .958 .003 .044 

4. Measurement Residuals 40 846.863 275 3.080 .946 .015 .045 

Note: Unconstrained Model: All the parameters are predicted freely.  

Measurement Weights Model = All Factor loadings are constrained (equated).  

Structural Covariances Model = All Factor loadings + factor variances and covariances are constrained (equated).  

Measurement Errors Model = All Factor loadings + factor variances + factor covariances + error variances are 

constrained (equated). 
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3.3. Measurement Invariance by School Types 

Goodness of Fit Indexes of the Baseline Measurement Model for School Type 

In the baseline measurement model based on the school types, the goodness of fit indexes were 

found to be as follows:  

✓ for science high school teachers 𝑋65
2 =163.060; 𝑋2/sd=2.509; GFI=0.885; CFI=0.937 and 

RMSEA=.095; 

✓ for Anatolian high school teachers 𝑋65
2 =328.329; 𝑋2/sd=5.051; GFI=0.927; CFI=0.953 

and RMSEA=.083; and  

✓ for vocational high school teachers 𝑋65
2 =224.257; 𝑋2/sd=3.45; GFI=0.906; CFI=0.947 

and RMSEA=.093.  

In conclusion, the baseline measurement model in Figure 1 displayed a high level of model fit 

for three school types. 

3.4. Configural, Measurement Weight, Structural Covariance, and Measurement 

Residual Invariance of the Measurement Model for School Type 

The unstandardized estimated parameters of the model are given with path diagram for school 

types in Figure 3, below, and the main findings regarding the measurement invariance 

according to the school types are presented in Table 5 below. 

Table 5. Configural, measurement weight, structural covariance, and measurement residual invariance 

results by branch.  

Model 
Number of 

parameters 
𝑋2 df 𝑋2/𝑑𝑓 CFI ΔCFI RMSEA 

1. Unconstrained (Configural) 120 715.646 195 3.670 .949  .051 

2. Measurement Weights  96 794.010 219 3.626 .943 .003 .050 

3. Structural Covariances  90 820.660 225 3.647 .941 .005 .051 

4. Measurement Residuals 40 1143.416 275 4.158 .914 .035 .055 

Note: Unconstrained Model: All the parameters are predicted freely.  

Measurement Weights Model = All Factor loadings are constrained (equated).  

Structural Covariances Model = All Factor loadings + factor variances and covariances are constrained (equated).  

Measurement Errors Model = All Factor loadings + factor variances + factor covariances + error variances are 

constrained (equated). 

As it seen in Table 5, according to the unconstrained (configural) model, the changes in CFI in 

the models obtained by constraining, in sequence, measurement weights, and structural 

covariances were less than .01. However, when error residuals constrained the changes in CFI 

was found to be more than .01. Hence, the measurement model has provided configural, 

measurement weight, and structural covariance invariance; but, not provided for measurement 

residual invariance across three school types. 
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Figure 3. Path diagram for configural, measurement weight, structural covariance, and measurement 

residual invariance of the measurement model for school type.  

 

Note: Only 3 covariance estimates (ee5 < -- > ee3=.024 with p=.226; ea7 < -- > ea8=.033 with p=.054; and ea5 < 

-- > ea2=.036 with p=.015) were not found to be significant, all the other parameters were found to be significant. 

3.5. Measurement Invariance by Genders 

Goodness of Fit Indexes of the Baseline Measurement Model for Gender 

In the baseline measurement model based on the gender, the goodness of fit indexes were found 

to be as follows:  

✓ for male teachers 𝑋65
2 =164.122; 𝑋2/sd=2.525; GFI=0.953; CFI=0.978 and RMSEA=.057; 

and  

✓ for female teachers 𝑋65
2 =324.513; 𝑋2/sd=4.993; GFI=0.927; CFI=0.957 and 

RMSEA=.084. 

In conclusion, the baseline measurement model in Figure 1 displayed a high level of model fit 

for the two genders. 
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3.6. Configural, Measurement Weight, Structural Covariance, and Measurement 

Residual Invariance of the Measurement Model for Gender 

The unstandardized estimated parameters of the model are given with path diagram for genders 

in Figure 4, below, and the main findings regarding the measurement invariance according to 

the genders are presented in Table 6 below. 

Figure 4. Path diagram for configural, measurement weight, structural covariance, and measurement 

residual invariance of the measurement model for gender.  

 
Note: Only 3 covariance estimates (ee5 < -- > ee3=.020 with p=.303; ea7 < -- > ea8=.032 with p=.061; and ea5 < 

-- > ea2=.035 with p=.017) were not significant, all other parameters were found to be significant. 

Table 6. Configural, measurement weight, structural covariance, and measurement residual invariance 

results by branch.  

Model 
Number of 

parameters 
𝑋2 df 𝑋2/𝑑𝑓 CFI ΔCFI RMSEA 

1. Unconstrained (Configural) 80 488.635 130 3.759 .966  .052 

2. Measurement Weights  68 505.893 142 3.563 .965 .001 .050 

3. Structural Covariances  65 507.348 145 3.499 .966 .000 .049 

4. Measurement Residuals 40 610.502 170 3.591 .958 .008 .050 

Note: Unconstrained Model: All the parameters are predicted freely.  

Measurement Weights Model = All Factor loadings are constrained (equated).  

Structural Covariances Model = All Factor loadings + factor variances and covariances are constrained (equated).  

Measurement Errors Model = All Factor loadings + factor variances + factor covariances + error variances are 

constrained (equated). 
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As it seen in Table 6, according to the unconstrained (configural) model, the changes in CFI in 

the models obtained by constraining, in sequence, measurement weights, structural covariances, 

and measurement residuals were less than .01. Hence, the measurement model has provided 

configural, measurement weight, structural covariance, and measurement residual invariance 

across two genders. 

4. DISCUSSION and CONCLUSION 

This study investigates the measurement invariance of the Nanoscience and Nanotechnology 

Awareness Scale (NSTAS) for three teacher branches, three school types, and two genders by 

using the covariance structural analysis to test configural and metric invariances.  

There is need to plan and implement NSNT education at primary, secondary, undergraduate, 

and graduate levels, since teachers’ knowledge and competences are the key to education. 

Factors affecting awareness and knowledge level of teachers/teacher trainees in NSNT should 

be determined and analyzed before implementing education programs (Hingant & Able, 2010; 

Jones et al., 2013). The NSTAS instrument was originally developed by Dyehouse et al. (2008) 

to promote awareness and factual knowledge among higher education students in the USA 

about nanotechnology uses, so students become acquainted with nanotechnology as a new field 

of research and innovation affecting society. The greater objective was to motivate university 

students to academic and career options in the field.  

Braeken and Blömeke (2016) pointed out, “to allow for making group comparisons in terms of 

correlations with external variables, the stricter requirement of equal factor loadings” across 

groups (i.e., metric or ‘weak’ invariance) needs to hold. They also pointed out that “if we wish 

to directly compare observed scale sum scores between groups, then additionally, the residual 

item variances would be required to be equal across groups, such that every item can be 

considered equally reliable across groups”. There are some group comparisons and some 

educational decisions based on these comparisons regarding nanotechnology and nanoscience 

using NSTAS scores. In terms of objectivity features of scientific research, to test whether the 

structural validity or the measurement model of the NSTAS scale works in different subgroups 

in the same way. In other words, it is extremely important to determine whether the 

measurement tool provides biased group results using the measurement invariance approach. 

Wicherts (2016) emphasized that measurement invariance is very important for the validity of 

tests. In the literature, we could not find any study about measurement invariance in the field 

of nanotechnology. Very few studies have been found in the literature on measurement 

instruments used in hard sciences. Some of them are given below.  

Rocabado et al. (2019) performed measurement invariance testing for the configural, metric, 

and scalar models comparing black female students and all other students within the traditional 

and flipped courses for the two-factor model prescribed for the pre and posttests. Their analysis 

results showed that configural, metric, and scalar invariance was ensured. Maier et al. (2013) 

developed a preschool teachers’ attitudes and beliefs toward science teaching scale. They used 

teacher ethnicity, education level, and experience level as subgroups. They conclude that the 

three factors remained invariant across each subgroup. Luo et al. (2019) presented validity 

evidence of scores produced from the S-STEM measurement tool, and they concluded that 

measurement invariance results showed that the instrument items in the surveys measured the 

same constructs in the same ways across gender, age groups, and races/ethnicities. Braeken and 

Blömeke (2016) investigated the measurement equivalence of teachers’ beliefs across countries 

for the case of ‘mathematics as-a fixed-ability’. They concluded that data provided configural 

and metric invariance but did not provide scaler invariance across countries. Clearly none of 

the measurement invariance studies cited provide indisputable explanation about the steps of 

invariance measurement. It is obvious that there is a deficiency in the hard science literature in 
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terms of emphasizing the importance of measurement invariance and elaborating step by step 

instructions and guidance. 

Having examined the measurement model invariance with respect to configural, measurement 

weight, and structural covariance invariance for three groups of branches, three group of school 

types and two groups of genders, the present study arrived at the conclusion that configural, 

measurement weight and structural covariance invariances were ensured for branches, school 

types and genders. Also, residual invariance was ensured for genders. Residual invariances are 

not provided for branches, and school types leading us to conclude that not every item can be 

considered equally reliable across those groups. 

In conclusion, the results of this study provide evidence that the measurement invariance 

requirement for valid group comparisons for the Nanoscience and Nanotechnology Awareness 

Scale has been satisfied; measurement invariance can be successfully implemented in science 
and technology education. Casas and Blanco-Blanco (2017) acknowledged using the method 

for Social Cognitive Career Theory (SCCT) models in predicting mathematical/scientific 
interests and occupational aspirations among Colombian secondary students. Another 

successful application was by Caputo (2017) in science and mathematics education of 7th grade 

secondary students in Italy. The Measure of Acceptance of the Theory of Evolution (MATE, a 
single-factor instrument that assesses an individual’s overall acceptance of evolutionary theory) 

was tested to assess how it operates differently when administered to a population of non-
science major preservice elementary teachers when compared with the reference population of 

in-service high school biology teachers and found to be reliable with the measurement 
invariance approach (Wagler & Wagler, 2013). As a result, it has been proved that the NSTAS 

scale will not generate biased measurements in comparing groups by teacher branches, school 
types and gender. Since the internal structure of NSTAS holds for different groups, NSTAS 

scale can be safely used to compare branch, school type and gender groups. Testing and 
interpreting the measurement invariance with the covariance structure approach using IBM 

AMOS-24, implemented with cases in this study, can be applied to all scales aimed at 

comparing different groups.  
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6. APPENDIX 

Table A1. Nanotechnology Awareness Instrument (Dyehouse et al., 2008)  

 

For the following items, please indicate the extent to which you agree or 

disagree using the following scale: Strongly disagree, disagree, neutral, 

agree, or strongly agree. 

S
tr

o
n

g
ly

 d
is

ag
re

e 

D
is

ag
re

e 

N
eu

tr
al

 

A
g

re
e 

S
tr

o
n

g
ly

 a
g
re

e 

What is your awareness of nanotechnology? I can: 

1. Name a nanoscale-sized object.      

2. Describe one way nanotechnology directly impacts my life.      

3. Name a field of study that currently conducts nanotechnology re-

search. 

     

4. Describe one way nanotechnology may benefit society/humankind.      

5. Name an application of nanotechnology.      

6. Describe a process to manufacture objects at the nanoscale.      

7. Name an instrument used to make measurements at the nanoscale.      

8. Describe one way nanotechnology may directly impact my life in the 

future. 

     

 

 

For the following items, please indicate the extent to which you have par-

ticipated in each activity using the following scale: Not at all/never, very 

little, sometimes/ occasionally, a fair amount, or a great deal. 
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What is your exposure to nanotechnology? I have:      

1. Heard the term nanotechnology.      

2. Read [something] about nanotechnology.      

3. Watched a program about nanotechnology.      

4. Had one [or more] instructors/teachers talk about nanotechnology in 

class. 

     

5. Participated in an activity involving nanotechnology [lab, project,…].      

6. Taken a class about nanotechnology.      
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Table A2. Nanoscience and Nanotechnology Awareness Scale (NSTAS) - Turkish Version. 
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1. Nanoölçek boyutunda bir nesne adı söyleyebilirim.      

2. Nanoteknolojinin hayatımı doğrudan etkileyen bir yöntemini 

söyleyebilirim. 
     

3. Bugünlerde nanoteknoloji araştırması yürüten bir çalışma alanı 

ismi söyleyebilirim. 
     

4. Nanoteknolojinin topluma/insanlığa faydalı olabilecek bir 

yöntemini tanımlayabilirim. 
     

5. Bir nanoteknoloji uygulamasının adını söyleyebilirim.      

6. Nanoölçekte nesneler üretmek için kullanılan bir yöntemi 

tanımlayabilirim. 
     

7. Nanoölçekte ölçüm yapmakta kullanılan bir araç ismi 

söyleyebilirim. 
     

8. Gelecekte nanoteknolojinin hayatımı doğrudan etkileyebilecek 

bir yöntemini söyleyebilirim. 
     

 

 

 

Deneyim (etkileşim) Alt Ölçeği 

(Exposure Subscale) H
iç
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N
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Ç
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H
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7. Nanoteknoloji terimini duydum.      

8. Nanoteknoloji hakkında bir şeyler okudum.      

9. Nanoteknoloji hakkında bir program izledim.      

10. Sınıfta bir (veya daha fazla) öğretmen/öğretim elemanının 

nanoteknoloji hakkındaki konuşmalarını dinledim. 
     

11. Nanoteknoloji konusunun işlendiği bir etkinliğe katıldım 

(laboratuvar çalışması, proje, seminer, konferans). 
     

12. Nanoteknoloji hakkında bir ders aldım.      

 

 


